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Channel City Camera Club Requirements for Exhibition 
This document details the requirements for accepting print and digital images for exhibition by the Channel City 
Camera Club. 

General Requirements 
The following requirements apply to both print and digital entry. 

• Each entered image shall be solely the product of the entering member. No commercially produced 
elements e.g. stock photographs, may be used to produce the image. 

• An image that has been given an Acceptance award in a club Exhibition cannot be submitted again for 
exhibition. 

Print Requirements 
A print entered into the Exhibition must adhere to the following requirements. 

• Subject: there is no restriction on the subject material or the technique used in creating the image. 
• Quantity: print submission is limited to one print each Exhibition.  
• Color: there is no color restriction; prints may be black and white, toned, or in color.  
• Material: prints can be printed on materials other than paper provided they can be handled as a light 

weight flat surface less than 1” thick and stand on the exhibition easel.  
• Process: prints may be chemically or computer processed by the submitter or by a commercial provider. 

The photographer must have performed all image capture, adjustments, and preparation.  
• Score Sheet: the photographer’s name and the print’s title shall be submitted by e-mail to the club’s 

competition e-mail address, competition@cccameraclub.com, before midnight on the Friday evening 
prior to the exhibition. A confirmation notice will be returned when this e-mail is processed. 

• Digital Copy: a digital copy of the print should be attached to the e-mail mentioned above for possible use 
in the Angle and the club’s web site. This file should be in the same format as for the digital file categories 
with a file name of CatTitleArtist.jpg, where Cat is the Category abbreviation Pri for Print. Do not 
include spaces in the file name. 

o Example: the print “Before the Storm” submitted by John Smith would have the digital copy file 
name, PriBeforeTheStormSmith.jpg. 

• Size: the size of the print shall not be smaller than 5” x 7” or larger than 13” x 19”, horizontal or vertical. 
• Mounting: all prints shall be mounted on a suitable backing board such as foam core board and mounted 

by dry mounting, adhesive spray, tape, or mounting tabs. If a window cutout mat is used to frame the 
image, the backing and framing mat should be attached to each other to provide secure handling during 
exhibition. Do not use a wall frame or cover the photograph with glass or acrylic. The maximum size of the 
backing board and mat is 20” x 24", horizontal or vertical. 

• Identification: the photographer’s name and the image title shall be placed at the upper-left corner on the 
back of the backing board. This information must be printed clearly so it can be read in low light during the 
exhibition.  

• Print Submission: the print shall be brought to Farrand Hall by 7:15pm on Exhibition night to allow time 
for review by the judges. The print shall be removed after the Exhibition is over. 

• Suitability: if there are questions about whether a print is suitable for exhibition, please contact the 
Director of Print Competition. A decision by the Director of Prints that a print submission does not meet 
the requirements stated above is final and the print will not be included in that night’s exhibition. Any 
appeal to this decision should be made to the President of the club. 

Digital File Requirements 
There are 5 categories of digital exhibition. 

• Creative: an image that is imaginative, inventive, original, fanciful, or ingenious. The image may be 
manipulated. 
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• Nature: the nature photography category is restricted to the use of the photographic process to depict 
observations from all branches of natural history, except anthropology and archeology, in such a fashion 
that a well informed person will be able to identify the subject material and to certify as to its honest 
presentation. 

o All adjustments must appear natural. 
o The story telling value of a photograph must be weighed more than the pictorial quality while 

maintaining a high technical quality.   
o Human elements shall not be present, except where those human elements enhance the nature 

story1.  The presence of scientific bands, scientific tags or radio collars on wild animals is 
permissible.  

o Photographs of artificially produced hybrid plants or animals, mounted specimens, or obviously set 
arrangements, are ineligible, as is any form of manipulation that alters the truth of the photographic 
statement.   

o No techniques that add to, relocate, replace, or remove pictorial elements except by cropping are 
permitted. Techniques that enhance the presentation of the photograph without changing the nature 
story or the pictorial content are permitted.   

• People: any depiction of human beings. Formal or casual portraiture, documentary, and photo-journalistic 
images are all appropriate as is an image of one or multiple people. Expressive images of specific body 
parts such as the eyes, hands or face are all allowed. 

• Pictorial: an open-ended category that includes images of any subject created using any technique. 
• Non-Judged: this category is not available during every exhibition; please refer to the Angle to determine 

when this category is being held. The non-judged category has the following specific rules. 
o Subject: there is no restriction on the subject material or the technique used in creating the image. 
o Quantity: non-judged digital file submission is limited to one digital file for each Exhibition and 

there shall be no other submissions in the other print or digital categories. 
 
A digital file entered into the Exhibition must adhere to the following requirements. 

• Subject: the subject material must adhere to the requirements of the specific category that the digital file is 
submitted into as further limited by the Special Assignment if appropriate. 

• Quantity: digital file submission to be judged is limited to one digital file for each category at each 
Exhibition. Since 3 judged categories occur during each Exhibition, digital file submission is limited to a 
total of 3 digital files for each exhibition. 

• Color: there is no color restriction; images may be black and white, tinted, or in color.  
• Process: the photographer must have performed all image capture, adjustments, and preparation.  
• Digital File Format: all images shall be submitted in the JPEG (.jpg) file format. It is suggested that you 

use the highest quality setting when creating the digital file. Save file in Baseline Standard or Baseline 
Optimized (not Progressive). Guidance on File Saving appears in the Technical Detail section at the end of 
this document. 

• Image Size: the display size for the club’s projector is 1400 pixels horizontal by 1050 pixels vertical. 
Images should fit within this boundary and the horizontal and vertical dimensions cannot be interchanged. 
Images that are not properly sized will be resized by the projector and may show a slight decrease in image 

                                                      
1 One example where a human element is allowed would be a barn swallow or a barn owl in its nest since these 
structures are normal habitat for the creature.  A bird at a nest box would not be considered acceptable.  On the 
surface it appears to be a dual standard until you take another factor into account.  Man made the barn but not for 
the benefit of the wildlife.  The wildlife infringes on man's work.  The nest box was made by man for the wildlife so is 
intruding on nature even though he is helping nature.  Another example is a bird on a fence post, provided the 
fence post has been minimized.  It is mostly a value call on the part of the judge.  If the human element just 
happens to be in the image, such as in the distant background (such as buildings, roof tops, power lines, roadways, 
bridges, etc.) it is considered a non story telling human element.  If the main nature subject is actually making use 
of a human element that was not initially created for the nature subject, it could be considered contributing to the 
nature story of the subject.  Also part of the value call is how prominent the human element is.  A pelican perched 
on a piling at the end of a wharf may be acceptable but including a large portion of the wharf is not. 
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quality. The value of image resolution is not used by the projector and may be ignored. Guidance on Image 
Resizing appears in the Technical Detail section at the end of this document. 

• File Naming: digital files shall be named without spaces using the following filename format, 
CatTitleArtist.jpg, where 

o Cat is the Category abbreviation: Cre for Creative, Nat for Nature, Peo for People, Pic for 
Pictorial, Non for non-judged, or Pri for Print. 

o Title is your title for the image; capitalize the first letter of each word but do not put a space 
between words 

o Artist is your last name or if needed, your first initial followed by your last name. 
o Do not include spaces in the file name. 
o Example: the Nature image “Before the Storm” submitted by Betty Smith (a second member with 

the last name, Smith) would have the file name, NatBeforeTheStormBSmith.jpg. 
• Color Space: The recommended color space is sRGB. If you are not familiar with color spaces, ignore this 

requirement but please understand that a slight color shift may occur when the image is projected. 
Guidance on Color Space Conversion appears in the Technical Detail section at the end of this document. 

• Macintosh Submission: The suggested gamma for a Mac computer is 2.2. If you are not familiar with 
gamma settings or if you choose to use a different gamma value, please understand that your image when 
projected may appear slightly dark; you may want to add brightness to compensate for this situation. 
Guidance on gamma selection for a Mac appears in the Technical Detail section at the end of this 
document. 

• Digital File Submission: digital files are to be submitted by attachment to an e-mail sent to the club’s 
competition e-mail address, competition@cccameraclub.com. Submit multiple images as individual 
attachments to a single e-mail if possible. Do not place multiple images into a .zip or similar compressed 
file. The e-mails must be submitted before midnight on the Friday evening prior to the exhibition. A 
confirmation notice will be returned when the entry is processed. 

• Digital Projector: please understand that even with the club’s excellent digital projector, there can be a 
variation in color and tonality between the image you see on your home monitor and the image that is 
projected by the club. 

• Suitability: if there are questions about whether a digital file is suitable for exhibition, please contact the 
Director of Projected Image. A decision by the Director of Projected Image that a digital file submission 
does not meet the requirements stated above is final and that image will not be included in that night’s 
exhibition. Any appeal to this decision should be made to the President of the club. 

Judging 
Judging will be performed by three judges selected by the Director of Judges. 

• Performance: the judges shall verbally evaluate all prints and digital files. The judges shall also provide a 
score for all submissions other than the non-judged digital images. 

• Scoring: the prints and digital files shall be judged on a scoring scale of 5 through 9 with the following 
criteria, 

o Score of 5: this is a below-average image.  
o Score of 6: this is an average image that has some good and some bad aspects.  
o Score of 7: this is a very good image that should be considered for an award within the camera 

club.  
o Score of 8: this is a very high-quality image that has a minor defect.  
o Score of 9: this is a very high-quality image of great artistic and technical skill.  

• Acceptance: an image that reaches a score of 21 by summing the score of the 3 judges is said to achieve 
Acceptance and will be eligible for the Image-of-the-Year Award.  

o If less that 30% of the entries in a given category achieve Acceptance, the criterion of reaching a 
score of 21 is reduced to a value at which 30% of the entries in a given category do achieve 
Acceptance. 

• Acceptance Variation: there are several variations to the Acceptance scoring to compensate for not having 
3 judgments of the image, 



2/16/2010 Channel City Camera Club Exhibition Requirements Page 4 

o If the club judge evaluates their own image, they will disqualify themselves by scoring a 5 and the 
cumulative score will reflect that one judge was not available for that image. 

o If only 2 judges are available, the total score is increased by 50% (e.g., 2 scores of 7 = 14, 
increased by 50% gives a cumulative score of 14+7=21).  

o If only 1 judge is available, the score is increased by 200% (e.g., 1 scores of 7 increased by 200% 
gives a cumulative score of 7+14=21).  

• Posting of Scores: the scores from the judging will be posted in the Scores section of the club’s web site, 
www.cccameraclub.com. 

• Posting of Images: the digital images submitted for exhibition will be posted on the club’s picture web 
site, picasaweb.google.com/CCCameraClub1. 

• Criteria: all decisions by the judges are final. 

Awards 
All prints and digital images that achieve Acceptance are shown at the club’s Annual Awards Banquet. In 
addition, two sets of awards are given at the Annual Awards Banquet for photographic excellence. 

• Cumulative Awards: recognition is given for the photographers with the 3 highest cumulative scores over 
the year for each category: print, creative, nature, people, and pictorial. In each case, the photographer’s 
lowest score for the year will not be counted in the cumulative calculation. The current cumulative value 
for each photographer is available in the Scores section of the club’s web site, www.cccameraclub.com. 

• Image-of-the-Year Awards: recognition is given for the photographers whose work is judged the best for 
each category: print, creative, nature, people, and pictorial. All prints and digital files that have reached the 
level of Acceptance are eligible for this award. This judging is performed during a special closed judging 
session in December with non-member judges and the results are not announced until the Annual Awards 
Banquet. 

Technical Detail 
This section provides guidance in performing the technical requirements for digital file submission. Specific steps 
are referenced to the current version of Adobe Photoshop but similar procedures are available in other image 
editing software. 
 
File Saving 
1. File > Save As 
2. Set File Name in the format, CatTitleArtist, where Cat denotes the category and is either Cre for Creative, Nat 
for Nature, Peo for People, Pic for Pictorial, Non for non-judged, and Pri for Print. 
3. Set Format = JPEG 
4. Check the ICC Profile box 
5. Click on SAVE 
6. Set Quality = 12 (maximum) 
7. Set Format Options = Baseline (Standard); note: Baseline (Optimized) is acceptable but Progressive is not 
8. Click on OK 
 
Image Resizing: Method #1 – Image Resize command 
1. Image > Image Size  
2. Check the Resample Image box and choose an interpolation method (normally Bicubic) 
3. Check the Constrain Proportions box  
4. Set Pixel Dimensions to adjust the size of your image to match the club’s digital projector.  

• For a landscape mode/horizontal image, set the width to 1400 pixels and the height will be automatically 
adjusted.  

• For a portrait mode/vertical image, set the height to 1050 pixels and the width will be automatically 
adjusted.  

5. Click on OK 
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Image Resizing: Method #2 – Fit Image command 
1. File > Automate > Fit Image 
2. Set Width = 1400 pixels and Height = 1050 pixels 

• The image will be automatically resized to fit within these constraints 
3. Click on OK 
 
Color Space Conversion 
1. Edit > Convert to Profile (for Elements, this is Image > Convert Color Profile) 
2. If Source Space = sRGB IEC…, stop here as image is already in the correct Color Space 
3. Set Destination Space = sRGB IEC… 
4. Unless you have a specific reason, set Engine = Adobe (ACE), Intent = Relative Colorimetric, and check the 3 
boxes (ignore this step for Elements) 
5. Click on OK 
6. Save this version of your file for exhibition with a unique name 
 
Gamma Selection for a Mac Computer 
1. Preferences > Display > Calibrate > Display Calibration 
2. Select 1.8 or 2.2 

 


